
 

                                                          
£ÀÄr 

 

F QÃ°ªÀÄuÉ «£Áå¸À PÀ£ÁðlPÀ À̧PÁðgÀ ¤UÀ¢¥Àr¹gÀÄªÀ ²µÀÖvÉUÉ C£ÀÄUÀÄtªÁVzÉ. 
QÃ°ªÀÄuÉ«£Áå À̧ 
PÀ£ÀßqÀ UÀtPÀ QÃ°ªÀÄuÉ «£Áå À̧ JAzÀgÉ, UÀtPÀ QÃ°ªÀÄuÉAiÀÄ AiÀiÁªÀ QÃ°UÉ AiÀiÁªÀ PÀ£ÀßqÀ 
PÀëgÀªÀ£ÀÄß UÉÆvÀÄÛªÀiÁqÀÄªÀÅzÀÄ JA§ÄzÉÃ DVzÉ.  

GzÁºÀgÀuÉUÉ `A' CPÀëgÀªÀ£ÀÄß UÀÄgÀÄw¹gÀÄªÀ QÃ°AiÀÄ£ÀÄß MwÛ `C' CPÀëgÀªÀ£ÀÄß ¥ÀqÉAiÀÄÄªÀAvÉ 
vÀAvÁæA±ÀzÀ ªÀÄÆ®PÀ UÀtPÀPÉÌ ¤zÉÃð±À£À ¤ÃqÀ§ºÀÄzÀÄ. C®èzÉ £ÀªÀÄUÉ ¨ÉÃPÁzÀ CPÀëgÀªÀ£ÀÄß 
£ÀªÀÄUÉ EµÀÖªÁzÀ QÃ°¬ÄAzÀ ¥ÀqÉAiÀÄÄªÀAvÉ vÀAvÁæA±ÀªÀ£ÀÄß ¹zÀÞ¥Àr¸À§ºÀÄzÀÄ. DzÀgÉ F jÃw 
§¼ÀPÉzÁgÀjUÉ ¨ÉÃPÉ¤¹zÀ §zÀ¯ÁªÀuÉUÀ¼À£ÀÄß ªÀiÁrPÉÆ¼ÀÄîªÀ ¸Ë®¨sÀåªÀ£ÀÄß ¤ÃrzÀ°è 
UÉÆAzÀ®UÀ¼ÁUÀÄvÀÛªÉ. DzÀÝjAzÀ¯ÉÃ EAVèµïUÁV ¤¢ðµÀÖ¥Àr¹gÀÄªÀ ªÀåªÀ¸ÉÜAiÀÄ£ÀÄß AiÀiÁgÀÆ 
§zÀ¯Á¬Ä¸ÀÄªÀÅ¢®è. PÀ£ÀßqÀPÀÆÌ EAvÀºÀ ²µÀÖvÉCUÀvÀåªÁVzÉ.  
  

£ÀÄrAiÀÄ §¼ÀPÉ - £ÀÄr DgÀA¨sÀ  
£ÀÄr'AiÀÄ C£ÀÄ¸ÁÜ¥À£É DzÀ PÀÆqÀ¯É ¥ÀæzÀ±ÀðPÀvÉgÉ (ªÀiÁ¤lgï) ªÉÄÃ¯É Nudi 4.0 JA§ 
¯ÁAbÀ£ÀªÀÅ (Icon) ªÀÄÆrgÀÄvÀÛzÉ.  



 `£ÀÄr'AiÀÄ£ÀÄß JAJ¸ï ªÀqïð CxÀªÁ EvÀgÀ vÀAvÁæA±ÀUÀ¼À°è §¼À¸À®Ä `Nudi 4.0' 
ªÉÄÃ¯É eÉÆÃr QèPï ªÀiÁr.  

`£ÀÄr' ¯ÁAbÀ£ÀªÀÅ ¥ÀæzÀ±ÀðPÀzÀ PÉ¼À CAa£À §® ªÀÄÆ¯ÉAiÀÄ°è PÁtÂ¹PÉÆ¼ÀÄîvÀÛzÉ 

`£ÀÄr ¥ÀzÀ¸ÀA¸ÁÌgÀPÀ' §¼À¸À®Ä ¥ÀæzÀ±ÀðPÀzÀ PÉ¼À CAa£À §®ªÀÄÆ¯ÉAiÀÄ°è PÁtÂ¹PÉÆ¼ÀÄîwÛgÀÄªÀ 
`£ÀÄr' ¯ÁAbÀ£ÀzÀ MªÉÄä QèQÌ¹.  

`£ÀÄr' §¼ÀPÉUÉ ¹zÀÞªÁzÁUÀ QÃ°ªÀÄtÂAiÀÄ ªÉÄÃ°£À SCROLL LOCK ¸ÀAPÉÃvÀ ¢Ã¥À 
ºÉÆwÛgÀÄvÀÛzÉ. EzÀ£ÀÄß ºÉÆwÛ¸À®Ä/Dj¸À®Ä SCROLL LOCK QÃ°AiÀÄ£ÀÄß MwÛj. £ÀÄrAiÀÄ 
4.0 £ÉAiÀÄ DªÀÈwÛAiÀÄ°è SCROLL LOCK QÃ §zÀ®Ä F12 QÃAiÀÄ£ÀÄß §¼À¸À§ºÀÄzÀÄ.  

FUÀ £ÀÄr vÀAvÁæA±ÀªÀÅ §¼ÀPÉUÉ ¹zÀÞ.  

PÀ£ÀßqÀzÀ°è UÀÄtÂvÁPÀëgÀUÀ¼ÀÄ ªÀÄvÀÄÛ ¸ÀAAiÀÄÄPÁÛPÀëgÀUÀ¼À£ÀÄß 
¥ÀqÉAiÀÄÄªÀ GzÁºÀgÀuÉUÀ¼ÀÄ 
C a SÉ Ke Y Z bÉ Ce 
D A SÉÃ KE YÁ ZA bÉÃ CE 
E i SÉÊ KY YÂ Zi bÉÊ CY 
F I SÉÆ Ko YÂÃ ZI bÉÆ Co 
G u SÉÆÃ KO YÄ Zu bÉÆÃ CO 
H U SË KV YÆ ZU bË CV 
IÄ R RA KM YÈ ZR bÀA CM 
IÆ RX RB KH Yñ ZRX bÀB CH 
J e UÀ g YÉ Ze d j 
K E UÁ gA YÉÃ ZE eÁ jA 
L Y V gi YÉÊ ZY f ji 
M o VÃ gI YÉÆ Zo fÃ jI 
N O UÀÄ gu YÉÆÃ ZO dÄ ju 
O V UÀÆ gU YË ZV dÆ jU 
CA aM UÀÈ gR YA ZM dÈ jR 
CB aH UÀñ gRX YB ZH dñ jRX 
PÀ k UÉ ge ZÀ c eÉ je 
PÁ kA UÉÃ gE ZÁ cA eÉÃ jE 
Q ki UÉÊ gY a ci eÉÊ jY 
QÃ kI UÉÆ go aÃ cI eÉÆ jo 
PÀÄ ku UÉÆÃ gO ZÀÄ cu eÉÆÃ jO 
PÀÆ kU UË gV ZÀÆ cU eË jV 
PÀÈ kR UÀA gM ZÀÈ cR dA jM 



PÀñ kRX UÀB gH ZÀñ cRX dB jH 
PÉ ke WÀ G ZÉ ce k z 
PÉÃ kE WÁ GA ZÉÃ cE kÁ zA 
PÉÊ kY X Gi ZÉÊ cY kÂ zi 
PÉÆ ko XÃ GI ZÉÆ co kÂÃ zI 
PÉÆÃ kO WÀÄ Gu ZÉÆÃ cO kÄ zu 
PË kV WÀÆ GU ZË cV kÆ zU 
PÀA kM WÀÈ GR ZÀA cM kÈ zR 
PÀB kH WÀñ GRX ZÀB cH kñ zRX 
R K WÉ Ge bÀ C kÉ ze 
SÁ KA WÉÃ GE bÁ CA kÉÃ zE 
T Ki WÉÊ GY c Ci kÉÊ zY 
TÃ KI WÉÆ Go cÃ CI kÉÆ zo 
RÄ Ku WÉÆÃ GO bÀÄ Cu kÉÆÃ zO 
RÆ KU WË GV bÀÆ CU kË zV 
RÈ KR WÀA GM bÀÈ CR kA zM 
Rñ KRX WÀB GH bÀñ CRX kB zH 
l q qÉÆ wo vÀÈ tR zsÁ DA 
mÁ qA qÉÆÃ wO vÀñ tRX ¢ü Di 
n qi qË wV vÉ te ¢üÃ DI 
nÃ qI qÀA wM vÉÃ tE zsÀÄ Du 
lÄ qu qÀB wH vÉÊ tY zsÀÆ DU 
lÆ qU qsÀ W vÉÆ to zsÀÈ DR 
lÈ qR qsÁ WA vÉÆÃ tO zsÀñ DRX 
lñ qRX rü Wi vË tV zsÉ De 
mÉ qe rüÃ WI vÀA tM zsÉÃ DE 
mÉÃ qE qsÀÄ Wu vÀB tH zsÉÊ DY 
mÉÊ qY qsÀÆ WU xÀ T zsÉÆ Do 
mÉÆ qo qsÀÈ WR xÁ TA zsÉÆÃ DO 
mÉÆÃ qO qsÀñ WRX y Ti zsË DV 
mË qV qsÉ We yÃ TI zsÀA DM 
lA qM qsÉÃ WE xÀÄ Tu zsÀB DH 
lB qH qsÉÊ WY xÀÆ TU £À n 
oÀ Q qsÉÆ Wo xÀÈ TR £Á nA 
oÁ QA qsÉÆÃ WO xÀñ TRX ¤ ni 
p Qi qsË WV xÉ Te ¤Ã nI 
pÃ QI qsÀA WM xÉÃ TE £ÀÄ nu 
oÀÄ Qu qsÀB WH xÉÊ TY £ÀÆ nU 
oÀÆ QU t N xÉÆ To £ÀÈ nR 



oÀÈ QR uÁ NA xÉÆÃ TO £Àñ nRX 
oÀñ QRX tÂ Ni xË TV £É ne 
oÉ Qe tÂÃ NI xÀA TM £ÉÃ nE 
oÉÃ QE tÄ Nu xÀB TH £ÉÊ nY 
oÉÊ QY tÆ NU zÀ d £ÉÆ no 
oÉÆ Qo tÈ NR zÁ dA £ÉÆÃ nO 
oÉÆÃ QO tñ NRX ¢ di £Ë nV 
oË QV uÉ Ne ¢Ã dI £ÀA nM 
oÀA QM uÉÃ NE zÀÄ du £ÀB nH 
oÀB QH uÉÊ NY zÀÆ dU ¥À p 
qÀ w uÉÆ No zÀÈ dR ¥Á pA 
qÁ wA uÉÆÃ NO zÀñ dRX ¦ pi 
r wi uË NV zÉ de ¦Ã pI 
rÃ wI tA NM zÉÃ dE ¥ÀÄ pu 
qÀÄ wu tB NH zÉÊ dY ¥ÀÆ pU 
qÀÆ wU vÀ t zÉÆ do ¥ÀÈ pR 
qÀÈ wR vÁ tA zÉÆÃ dO ¥Àñ pRX 
qÀñ wRX w ti zË dV ¥É pe 
qÉ we wÃ tI zÀA dM ¥ÉÃ pE 
qÉÃ wE vÀÄ tu zÀB dH ¥ÉÊ pY 
qÉÊ wY vÀÆ tU zsÀ D ¥ÉÆ po 
¥ÉÆÃ pO s̈Àñ BRX j ri ªË vV 
¥Ë pV s̈É Be jÃ rI ªÀA vM 
¥ÀA pM s̈ÉÃ BE gÀÄ ru ªÀB vH 
¥ÀB pH s̈ÉÊ BY gÀÆ rU ±À S 
¥sÀ P s̈ÉÆ Bo gÀÈ rR ±Á SA 
¥sÁ PA s̈ÉÆÃ BO gÀñ rRX ² Si 
¦ü Pi s̈Ë BV gÉ re ²Ã SI 
¦üÃ PI ¨sÀA BM gÉÃ rE ±ÀÄ Su 
¥sÀÄ Pu s̈ÀB BH gÉÊ rY ±ÀÆ SU 
¥sÀÆ PU ªÀÄ m gÉÆ ro ±ÀÈ SR 
¥sÀÈ PR ªÀiÁ mA gÉÆÃ rO ±Àñ SRX 
¥sÀñ PRX «Ä mi gË rV ±É Se 
¥sÉ Pe «ÄÃ mI gÀA rM ±ÉÃ SE 
¥sÉÃ PE ªÀÄÄ mu gÀB rH ±ÉÊ SY 
¥sÉÊ PY ªÀÄÆ mU ® l ±ÉÆ So 
¥sÉÆ Po ªÀÄÈ mR ¯Á lA ±ÉÆÃ SO 
¥sÉÆÃ PO ªÀÄñ mRX ° li ±Ë SV 
¥sË PV ªÉÄ me °Ã lI ±ÀA SM 



¥sÀA PM ªÉÄÃ mE ®Ä lu ±ÀB SH 
¥sÀB PH ªÉÄÊ mY ®Æ lU µÀ x 
§ b ªÉÆ mo ®È lR µÁ xA 
¨Á bA ªÉÆÃ mO ®ñ lRX ¶ xi 
© bi ªÀiË mV ¯É le ¶Ã xI 
©Ã bI ªÀÄA mM ¯ÉÃ lE µÀÄ xu 
§Ä bu ªÀÄB mH ¯ÉÊ lY µÀÆ xU 
§Æ bU AiÀÄ y ¯ÉÆ lo µÀÈ xR 
§È bR AiÀiÁ yA ¯ÉÆÃ lO µÀñ xRX 
§ñ bRX ¬Ä yi ¯Ë lV µÉ xe 
¨É be ¬ÄÃ yI ®A lM µÉÃ xE 
¨ÉÃ bE AiÀÄÄ yu ®B lH µÉÊ xY 
¨ÉÊ bY AiÀÄÆ yU ªÀ v µÉÆ xo 
¨ÉÆ bo AiÀÄÈ yR ªÁ vA µÉÆÃ xO 
¨ÉÆÃ bO AiÀÄñ yRX « vi µË xV 
¨Ë bV AiÉÄ ye «Ã vI µÀA xM 
§A bM AiÉÄÃ yE ªÀÅ vu µÀB xH 
§B bH AiÉÄÊ yY ªÀÇ vU ¸À s 
s̈À B AiÉÆ yo ªÀÈ vR ¸Á sA 
¨sÁ BA AiÉÆÃ yO ªÀñ vRX ¹ si 
©ü Bi AiÀiË yV ªÉ ve ¹Ã sI 
©üÃ BI AiÀÄA yM ªÉÃ vE ¸ÀÄ su 
¨sÀÄ Bu AiÀÄB yH ªÉÊ vY ¸ÀÆ sU 
s̈ÀÆ BU gÀ r ªÉÇ vo ¸ÀÈ sR 
s̈ÀÈ BR gÁ rA ªÉÇÃ vO ¸Àñ sRX 
¸É se ¼ÉÃ LE ¿A LXM ¸ÀÛø sfpR 
¸ÉÃ sE ¼ÉÊ LY ¿B LXH ¶Ìç xfkfri 
¸ÉÊ sY ¼ÉÆ Lo PÀÛ å kftfy 
¸ÉÆ so ¼ÉÆÃ LO 

¸ÀAAiÀÄÄPÁÛPÀëgÀUÀ¼À 
GzÁºÀgÀuÉUÀ¼ÀÄ µÀÖ å xfqfy 

¸ÉÆÃ sO ¼Ë LV PÀÌ kfk PÀÛç kftfr 
¸Ë sV ¼ÀA LM RÍ KfK ¥ÉÆæÃ pfrO 
¸ÀA sM ¼ÀB LH UÀÎ gfg vÉÆæåÃ tfrfyO 
¸ÀB sH ¾ rX WÀÎ Gfg vÀæåA tfrfyM 
ºÀ h ¾õÁ rXA YÐ ZfZ «±ÉÃµÀ CPÀëgÀUÀ¼ÀÄ 
ºÁ hA ¾Â rXi dÕ jfz dû jX 
» hi ¾ÂÃ rXI qÀé wfv ¥sóÀ PX 
»Ã hI ¾Ä rXu ¨Áå bfyA Ró KX 
ºÀÄ hu ¾Æ rXU s̈Àæ Bfr CªÀUÀæºÀ aºÉß 
ºÀÆ hU ¾È rXR ªÀÄå mfy s aX 



ºÀÈ hR ¾ñ rXRX «Äå mfyi     
ºÀñ hRX ¾õÉ rXe ¶ÖÃ xfqfrI     
ºÉ he ¾ÂÃ rXE tÄÚ NfNu     
ºÉÃ hE ¾õÉÊ rXY zÀÆÞ dfDU     
ºÉÊ hY ¾õÉÆ rXo zÉé dfve     
ºÉÆ ho ¾õÉÆÃ rXO ¸ÉÖÃ sfqE     
ºÉÆÃ hO ¾õË rXV zÉéöÊ dfvY     
ºË hV ¾A rXM vÉÆå tfyo     
ºÀA hM ¾B rXH µÉÆÚÃ xfNO     
ºÀB hH ¿ LX ¸ËÌ sfkV     
¼À L ¿õÁ LXA ±ÀéA SfvM     
¼Á LA ¿È LXR ¸ÀéB sfvH     
½ Li ¿ñ LXRX vÀìð tfsF     
½Ã LI ¿õÉ LXe µÀÖç xfqfr     
¼ÀÄ Lu ¿õÉÃ LXE vÉÆìåÃ tfsfyO     
¼ÀÆ LU ¿õÉÊ LXY £Àß nN     
¼ÀÈ LR ¿õÉÆ LXo PÉë äöÊ kfxfmY     
¼Àñ LRX ¿õÉÆÃ LXO µÉÖçöÊ xfqfrY     
¼É Le ¿õË LXV ¸Ààø sfpR     
         

  
   

PÀ£ÀßqÀzÀ ¸ÁªÀiÁ£Àå §gÀªÀtÂUÉAiÀÄAvÉ 
gÀ CPÀëgÀ¢AzÀ ªÉÆzÀ¯ÁUÀÄªÀ 
UÀÄtÂvÁPÀëgÀUÀ¼ÀÄ 

CPÁðªÉÇvÀÄÛ aºÉßAiÀÄ£ÀÄß §¼À¹PÉÆArgÀÄªÀAvÉ
gÀ CPÀëgÀ¢AzÀ ªÉÆzÀ¯ÁUÀÄªÀ UÀÄtÂvÁPÀëgÀUÀ¼ÀÄ 

gÀ CPÀëgÀPÉÌ 
EvÀgÀ 
ªÀåAd£ÀUÀ¼À 
MvÀÄÛUÀ¼ÀÄ 

  
GzÁºÀgÀuÉUÀ¼ÀÄ 

EvÀgÀ ªÀåAd£ÀUÀ½UÉ 
CPÁðªÉÇwÛ£À 
aºÉßAiÀÄ §¼ÀPÉ 

  
GzÁºÀgÀuÉUÀ¼ÀÄ 

gÀÌ rfk CgÀÌ arfk PÀð kF CPÀð akF 
gÀÍ rfK ªÀÄÆgÀÍ mUrfK gÀR KF ªÀÄÆRð mUKF 
gÀÎ rfg ªÀiÁgÀÎ mArfg UÀð gF ªÀiÁUÀð mAgF 
gÀÏ rfG s̈ÀgÀÏ BrfG WÀð GF s̈ÀWÀð BGF 
gÀÐ rfZ     Yð ZF     
gÀÑ rfc CgÀÑ£É arfcne ZÀð cF CZÀð£É acFne 
gÀÒ rfC ªÀÄÆgÉÒ mUrCe bÀð CF ªÀÄÆbÉð mUCeF 
gÀÓ rfj ªÀiÁgÀÓ mArfj dð jF ªÀiÁdð mAjF 
gÀÔ rfJ     gÀhÄð JF     
gÀÕ rfz     kð zF     



gÀÖ rfq ZÁgïÖ cArfqf lð qF ZÁmïð cAqfF 
gÀ× rfQ     oÀð QF     
gÀØ rfw §gÀÄØ brfdu qÀð wF §qÀÄð bwuF 
gÀÙ rfW     qsÀð WF     
gÀÚ rfN PÀgÀÚ krfN tð NF PÀtð kNF 
gÀÛ rft PÀgÁÛgÀ krftAr vÀð tF PÀvÁðgÀ ktAFr 
gÀÜ rfT CgÀÜ arfT xÀð TF CxÀð aTF 
gÀÝ rfd dgÁÝ jrfdA zÀð dF dzÁð jdAF 
gÀÞ rfD CgÀÞ arfD zsÀð DF CzsÀð aDF 
gÀß rfn PÀgÁßlPÀ krfnAqk £Àð nF PÀ£ÁðlPÀ knAFqk
gÀà rfp CgÀàuÉ arfpNe ¥Àð pF C¥ÀðuÉ apFNe 
gÀá rfP CgÀÏ arfP ¥sÀð PF CWÀð aGF 
gÀâ rfb dgÀÄâ jrfbu §ð bF d§Äð jbuF 
gÀã rfB     s̈Àð BF     
gÀä rfm PÀgÀä krfm ªÀÄð mF PÀªÀÄð kmF 
gÀå rfy DgÀå Arfy AiÀÄð yF DAiÀÄð AyF 
gÀæ rfr ¸ÀgÀæ£É srfrne gÀð rF     
gÀè rfl ¥ÉÃgÀè pErfl ®ð lF ¥ÉÃ®ð pElF 
gÀé rfv UÀgÀé grfv ªÀð vF UÀªÀð gvF 
gÀê rfS ªÀgÀê vrfS ±Àð SF ªÀAiÀÄð vyF 
gÀë rfx ºÀgÀë hrfx µÀð xF ºÀµÀð hxF 
gÀì rfs ¥ÀgÀÄì prfsu ¸Àð sF ¥À¸ÀÄð psuF 
gÀí rfh CgÀí arfh ºÀð hF CºÀð ahF 
gÀî rfL     ¼Àð LF     

  
ªÉÄÃ®ÌAqÀ JgÀqÀÄ gÀÆ¥ÀUÀ¼ÀÆ PÀ£ÀßqÀzÀ°è §¼ÀPÉAiÀÄ°èªÉ. 
  
  
ªÀÄvÀÛµÀÄÖ GzÁºÀgÀuÉUÀ¼ÀÄ CPÁðªÉÇwÛ£ÉÆqÀ£É ªÀÄvÀÛµÀÄÖ GzÁºÀgÀuÉUÀ¼ÀÄ 
CgÀÑ£É arfcne CZÀð£É acFne 
ªÀÄÆgÉÒ mUrfCe ªÀÄÆbÉð mUCeF 
s̈ÀjÓ Brfji s̈Àfð BjiF 
¥ÁjÖ pArfqi ¥Ánð pAqiF 
§gÀÄØ brfwu §qÀÄð bwuF 
¸ÀgÀà srfp ¸À¥Àð spF 
PÀgÀæ£É krfrne     
¸ÀgÀé srfv ¸ÀªÀð svF 
¤gÉÝÃ±À nirfdES ¤zÉÃð±À nidEFS 
CgÀÌ arfk CPÀð akF 



zÀÄgÉÎÃ±Àéj durfgESfvri zÀÄUÉÃð±Àéj dugEFSfvri 
ºÀgÉÆëÃzÁÎgÀ hrfxOdfgAr ºÀµÉÆÃðzÁÎgÀ hxOFdfgAr 

PÀ£ÀßqÀPÀÆÌ 26 QÃ°UÀ¼ÀÄ  

UÀtPÀUÀ¼À eÉÆvÉ EgÀÄªÀ QÃ°ªÀÄuÉUÀ¼À°è EAVèµï CPÀëgÀUÀ½UÉ EgÀÄªÀ 26 QÃ°UÀ¼À£ÀÄß ªÀiÁvÀæªÉÃ 
PÀ£ÀßqÀPÀÆÌ §¼À¹PÉÆAqÀgÉ CzÀÄ §¼ÀPÉUÉ À̧Ä® s̈ÀªÁUÀÄvÀÛzÉ. 

PÀ£ÀßqÀ s̈ÁµÉAiÀÄ°è PÉ¼ÀPÀAqÀ 51 CPÀëgÀUÀ¼ÀÄ/aºÉßUÀ¼ÀÄ FUÀ §¼ÀPÉAiÀÄ°èªÉ. 
13 À̧égÀUÀ¼ÀÄ (C, D, E, F, G, H, IÄ, J, K, L, M, N, O) 

`C' À̧égÀ À̧»vÀªÁzÀ 25 ªÀVÃðAiÀÄ ªÀåAd£ÀUÀ¼ÀÄ (PÀ, R, UÀ, WÀ, Y, ZÀ, bÀ, d, gÀhÄ, k, l, oÀ, 
qÀ, qsÀ, t, vÀ, xÀ, zÀ, zsÀ, £À, ¥À, ¥sÀ, §, s̈À, ªÀÄ) 

`C' À̧égÀ À̧»vÀªÁzÀ 9 CªÀVÃðAiÀÄ ªÀåAd£ÀUÀ¼ÀÄ (AiÀÄ, gÀ, ®, ªÀ, ±À, µÀ, À̧, ºÀ, ¼À) 

C£ÀÄ¸ÁégÀ(A), « À̧UÀð(B), CPÁðªÉÇvÀÄÛ (ð) ªÀÄvÀÄÛ ªÀÄÆ®ªÀåAd£ÀªÀ£ÀÄß ªÀÄÆr À̧®Ä §¼À̧ ÀÄªÀ 
CzsÁðPÀëgÀ aºÉß (ï, ºÀ®Avï) - MlÄÖ 4 aºÉßUÀ¼ÀÄ -- EªÉ®èªÀÇ Ȩ́Ãj 51 CPÀëgÀ/aºÉßUÀ¼ÁUÀÄvÀÛªÉ.  

EAVèµïUÁV §¼À̧ ÀÄªÀ 26 QÃ°UÀ¼ÀÄ [¸ÀºÀd(£ÁgÀä¯ï) ªÀÄvÀÄÛ MvÀÄÛ(²¥sïÖ) MqÀ£É 52 ¸ÁzsÀåvÉUÀ¼ÀÄ] 
ªÀiÁvÀæªÉÃ PÀ£ÀßqÀPÀÆÌ ¸ÁPÁUÀÄvÀÛzÉ. avÀæzÀ°è PÁtÂ¹gÀÄªÀAvÉ ¸ÁªÀiÁ£ÀåªÁV PÀ£ÀßqÀzÀ CPÀëgÀUÀ½UÉ CzÉÃ 
zsÀé¤AiÀÄÄ¼Àî EAVèÃµÀ CPÀëgÀzÀ QÃ°AiÀÄ£ÉßÃ ¤UÀ¢UÉÆ½¹zÁÝgÉ. GzÁ: k : PÀ; s : ¸À EvÁå¢. 

ªÀÄÆ®ªÀåAd£À ¨ÉÃPÁzÁUÀ vÉgÉAiÀÄ ªÉÄÃ¯É ªÀåAd£ÁPÀëgÀ ªÀÄÆrzÀ £ÀAvÀgÀ a£ÉíAiÀÄ QÃ°AiÀÄ£ÀÄß 
MwÛ CzÀ£ÀÄß ªÀÄÆ® ªÀåAd£ÀªÀ£ÁßV ¥ÀjªÀwð¸À§ºÀÄzÀÄ.  

UÀÄtÂvÁPÀëgÀUÀ¼ÀÄ ªÀÄvÀÄÛ ¸ÀAAiÀÄPÁÛPÀëgÀUÀ¼À£ÀÆß F «£Áå¸À¢AzÀ¯ÉÃ ¥ÀqÉAiÀÄ§ºÀÄzÀÄ. 

¥ÀzÀ¸ÀA¸ÁÌgÀPÀzÀ §¼ÀPÉ 

F ¥ÀzÀ ¸ÀA¸ÁÌgÀPÀªÀÅ WORDPAD ¥ÀzÀ ¸ÀA¸ÁÌgÀPÀªÀ£ÀÄß §ºÀÄªÁV ºÉÆÃ®ÄvÀÛzÉ.  

F ¸ÀA¥ÁzÀPÀªÀ£ÀÄß §¼À¹ £ÁªÀÅ AiÀiÁªÀ jÃwAiÀÄ PÀqÀvÀªÀ£ÀÄß ¹zÀÞ¥Àr¸ÀÄvÉÛÃªÉ JA§ÄzÀ£ÀÄß 
¤zsÀðj¸À®Ä¸ÀºÁAiÀÄPÀªÁzÀ DAiÉÄÌ QlQ vÉgÉAiÀÄ ªÉÄÃ¯É ªÀÄÆqÀÄvÀÛzÉ. EzÀgÀ°è £Á®ÄÌ 
DAiÉÄÌUÀ½gÀÄvÀÛªÉ.  

£ÀÄr ºÉÆ¸À zÀ¸ÁÛªÉÃdÄ (Nudi New Document)  

JZï.n.JA.J¯ï PÀqÀvÀ (HTML File)  

E¹Ì ¥ÀoÀå PÀqÀvÀ (ISCII Text File)  



CPÀëgÀ ¨sÁUÀ ¥ÀoÀå PÀqÀvÀ (Glyph Text File)  

EªÀÅUÀ¼À°è ¤ªÀÄUÉ ¨ÉÃPÁzÀÄzÀ£ÀÄß DAiÉÄÌ ªÀiÁrPÉÆAqÀÄ Ok UÀÄArAiÀÄ£ÀÄß MwÛzÉÆqÀ£É Nudi1 
JA§ ºÉÆ¸À PÀqÀvÀzÀ ¥ÀgÀzÉ ªÀÄÆqÀÄvÀÛzÉ. 

 
¥Àj«r ¥ÀnÖ :  
PÀqÀvÀ ¸ÀA¥ÁzÀ£É «£Áå¸À DAiÉÄÌ vÉÆÃj¸ÀÄ G¥ÀPÀgÀtUÀ¼ÀÄ QlQ ¸ÀºÁAiÀÄ  

PÀqÀvÀ: `PÀqÀvÀ' ªÉÄÃ¯É ¸ÀÆZÀPÀªÀ£ÀÄß MAiÀiÁÝUÀ MAzÀÄ G¥À¥Àj«r ¥ÀnÖ ªÀÄÆqÀÄvÀÛzÉ. £Á®ÄÌ 
UÀÄA¥ÀÄUÀ¼À°è ºÀvÀÄÛ ««zsÀ DAiÉÄÌUÀ¼ÀÄ EzÀgÀ°èªÉ.  
 
C) ºÉÆ¸À, vÉUÉ, ªÀÄÄZÀÄÑ, G½¸ÀÄ, CAvÉG½¸ÀÄ, AiÀÄÄnJ¥sóï-16gÀAvÉ G½¸ÀÄ, AiÀÄÄnJ¥sóï-
16gÀAvÉ G½¸ÀÄ  
D) ªÀÄÄ¢æ¸ÀÄ, ªÀÄÄzÀæt ªÀÄÄ£ÉÆßÃl, ªÀÄÄzÀæt ¹zÀÞvÉ  
E) EwÛÃa£À PÀqÀvÀUÀ¼ÀÄ  
F) ¤UÀð«Ä¸ÀÄ  

DAiÉÄÌUÀ¼ÀÄ: 
ºÉÆ¸À - `ºÉÆ¸À' JA§ F ªÀÄÄAZÉ «ªÀj¹zÀ CAPÀt ªÀÄÆqÀÄvÀÛzÉ  
vÉUÉ - ¤ÃªÀÅ FUÁUÀ¯ÉÃ »AzÉ G½¹gÀÄªÀ PÀqÀvÀªÀ£ÀÄß vÉUÉAiÀÄ®Ä  
ªÀÄÄZÀÄÑ - ¥ÀæzÀ±ÀðPÀzÀ ªÉÄÃ°gÀÄªÀ PÀqÀvÀªÀ£ÀÄß ªÀÄÄZÀÑ®Ä  
G½¸ÀÄ - ¥ÀæzÀ±ÀðPÀzÀ ªÉÄÃ°gÀÄªÀ PÀqÀvÀªÀ£ÀÄß G½¸À®Ä  
CAvÉG½¸ÀÄ - ¥ÀæzÀ±ÀðPÀzÀ ªÉÄÃ°gÀÄªÀ PÀqÀvÀªÀ£ÀÄß ºÉÆ¸À ºÉ¸Àj£À°è G½¸À®Ä 
AiÀÄÄnJ¥sóï-16 gÀAvÉ G½¸ÀÄ - ¥ÀæzÀ±ÀðPÀzÀ ªÉÄÃ°gÀÄªÀ PÀqÀvÀªÀ£ÀÄß AiÀÄÆ¤PÉÆÃqï ²µÀÖvÉAiÀÄAvÉ 
G½¸ÀÄ 
AiÀÄÄnJ¥sóï-8 gÀAvÉ G½¸ÀÄ - ¥ÀæzÀ±ÀðPÀzÀ ªÉÄÃ°gÀÄªÀ PÀqÀvÀªÀ£ÀÄß AiÀÄÆ¤PÉÆÃqï ²µÀÖvÉAiÀÄAvÉ 
G½¸ÀÄ 
ªÀÄÄ¢æ¸ÀÄ - ¥ÀæzÀ±ÀðPÀzÀ ªÉÄÃ°gÀÄªÀ PÀqÀvÀªÀ£ÀÄß ªÀÄÄ¢æ¸À®Ä  
ªÀÄÄzÀæt ªÀÄÄ£ÉÆßÃl - ¥ÀæzÀ±ÀðPÀzÀ ªÉÄÃ°gÀÄªÀ PÀqÀvÀzÀ ªÀÄÄzÀæt «£Áå¸ÀzÀ ªÀÄÄ£ÉÆßÃlPÁÌV  

ªÀÄÄzÀæt¹zÀÞvÉ - ¥ÀæzÀ±ÀðPÀzÀ ªÉÄÃ°gÀÄªÀ PÀqÀvÀªÀÅ AiÀiÁªÀ jÃw ªÀÄÄzÀætªÁUÀ¨ÉÃPÉA§ §UÉÎ 
¥ÀÆªÀð vÀAiÀiÁj ªÀiÁqÀÄªÀÅzÀPÁÌV  
EwÛÃa£À PÀqÀvÀ - EwÛÃZÉUÉ vÉUÉ¢gÀÄªÀ PÀqÀvÀUÀ¼À ºÉ¸ÀgÀÄUÀ¼ÀÄ  
¤UÀðªÀÄ£À - £ÀÄr ¥ÀzÀ¸ÀA¸ÁÌgÀPÀ¢AzÀ (NudiEditor) ºÉÆgÀ§gÀ®Ä 

¸ÀA¥ÁzÀ£É: `¸ÀA¥ÁzÀ£É' ¥Àj«rAiÀÄ ªÉÄÃ¯É ¸ÀÆZÀPÀªÀ£ÀÄß MAiÀiÁÝUÀ ªÀÄÆgÀÄ UÀÄA¥ÀÄUÀ¼À°è  
«AUÀr¹gÀÄªÀ JAlÄ DAiÉÄÌUÀ¼ÀÄ zÉÆgÉAiÀÄÄvÀÛªÉ.  
 
C. gÀzÀÄÝªÀiÁqÀÄ 



D. PÀvÀÛj¸ÀÄ, £ÀPÀ°¸ÀÄ, CAn¸ÀÄ, J¯ÁèDAiÉÄÌªÀiÁqÀÄ 
E. ºÀÄqÀÄPÀÄ, ªÀÄÄAzÉºÀÄqÀÄPÀÄ, §zÀ°¸ÀÄ 
F. DAiÉÄÌUÀ¼ÀÄ... 

DAiÉÄÌUÀ¼ÀÄ: 
gÀzÀÄÝªÀiÁqÀÄ - »A¢£À QæAiÉÄAiÀÄ£ÀÄß gÀzÀÄÝUÉÆ½¸À®Ä 
PÀvÀÛj¸ÀÄ - DAiÉÄÌ ªÀiÁrzÀ ªÀiÁ»w ¨sÁUÀªÀ£ÀÄß PÀvÀÛj¸À®Ä 
£ÀPÀ°¸ÀÄ - DAiÉÄÌ ªÀiÁrzÀ ªÀiÁ»w ¨sÁUÀªÀ£ÀÄß £ÀPÀ®Ä ªÀiÁr £ÀPÀ®Ä ¥sÀ®PÀzÀ°è Ej¸À®Ä  
CAn¸ÀÄ - £ÀPÀ®Ä ¥sÀ®PÀzÀ°è EgÀÄªÀ ªÀiÁ»wAiÀÄ£ÀÄß PÀqÀvÀzÀ ¨ÉÃPÉ¤¹zÀ eÁUÀzÀ°è CAn¸À®Ä  
J¯Áè DAiÉÄÌ ªÀiÁqÀÄ - PÀqÀvÀzÀ ¸ÀªÀÄUÀæ ªÀiÁ»wAiÀÄ£ÀÄß DAiÉÄÌªÀiÁqÀ®Ä 
ºÀÄqÀÄPÀÄ - CUÀvÀåªÁzÀ ¥ÀoÀå¨sÁUÀªÀ£ÀÄß ºÀÄqÀÄPÀ®Ä  
ªÀÄÄAzÉ ºÀÄqÀÄPÀÄ - »A¢£À DzÉÃ±ÀzÀAvÉ ªÀÄÄA¢£À ¥ÀoÀåzÀ®Æè ºÀÄqÀÄPÀ®Ä  
§zÀ°¸ÀÄ - ºÀÄqÀÄQzÀ ¥ÀoÀå s̈ÁUÀªÀ£ÀÄß ºÉÆ¸À ¥ÀoÀåPÉÌ §zÀ¯Á¬Ä¸À®Ä 
 

DAiÉÄÌUÀ¼ÀÄ -  

1. ¥ÀzÀ¥ÀjÃPÉëUÉ ¥ÀzÀPÉÆÃ±ÀzÀ DAiÉÄÌ :  
EzÀgÀ°è ªÀÄÄRåPÉÆÃ±À ªÀÄvÀÄÛ JgÀqÀ£ÉAiÀÄ PÉÆÃ±À JA§ JgÀqÀÄ ¸Ë® s̈ÀåUÀ¼À£ÀÄß ¤ÃqÀ¯ÁVzÉ. 
ªÀÄÄRåPÉÆÃ±ÀªÀ£ÀÄß AiÀiÁgÀÆ §zÀ°¸ÀÄªÀAw®è. §¼ÀPÉzÁgÀgÀÄ G¥ÀPÀgÀt-¥ÀzÀ¥ÀjÃPÉë §¼À¸ÀÄªÁUÀ 
¸ÉÃj¸À®Ä EaÒ¸ÀÄªÀ ºÉÆ¸À¥ÀzÀUÀ¼ÀÄ `JgÀqÀ£ÉAiÀÄ PÉÆÃ±À' zÀ°è zÁR¯ÁUÀÄvÀÛªÉ. 

2. ¥Àæw¨ÁjAiÀÄÆ £ÉÃgÀ£ÀÄrAiÀÄ£ÀÄß ¥ÁægÀA©ü¸ÀÄ DAiÉÄÌ : 
EzÀ£ÀÄß DAiÉÄÌ ªÀiÁrzÀgÉ UÀtPÀzÀ vÉgÉAiÀÄ ªÉÄÃ°gÀÄªÀ £ÀÄr 4.0 C£ÀÄß QèQÌ¹zÁUÀ £ÀÄr 
¯ÁAbÀ£ÀªÀÅ UÀtPÀ ¥ÀgÀzÉAiÀÄ ªÉÄÃ¯É PÉ¼À§®ªÀÄÆ¯ÉAiÀÄ°è PÀÄ½vÀÄPÉÆ¼ÀÄîvÀÛzÉ(Nudi direct). F 
DAiÉÄÌAiÀÄ£ÀÄß ªÀiÁqÀ¢zÀÝgÉ £ÀÄr 4.0 QèQÌ¹zÁUÀ ¥Àæw¨ÁjAiÀÄÆ £ÀÄr ¸ÀA¥ÁzÀPÀªÀÅ 
vÉgÉzÀÄPÉÆ¼ÀÄîvÀÛzÉ. 

3. ¥Àæw¨ÁjAiÀÄÆ ¥ÁægÀA¨sÀ vÉgÉAiÀÄ£ÀÄß vÉÆÃj¸ÀÄ DAiÉÄÌ :  
£ÀÄr 4.0 QèQÌ¹zÁUÀ ¥ÀæzÀ±ÀðPÀzÀ vÉgÉAiÀÄ ªÉÄÃ¯É £ÀÄrAiÀÄ ¥ÁægÀA¨sÀvÉgÉAiÀÄÄ ªÀÄÆqÀ¨ÉÃPÉÃ 
¨ÉÃqÀªÉÃ JA§ÄzÀ£ÀÄß E°è ¸ÀÆa¸À§ºÀÄzÁVzÉ. 
 
«£Áå¸À: `«£Áå¸À' ¥Àj«rAiÀÄ ªÉÄÃ¯É ¸ÀÆZÀPÀªÀ£ÀÄß MAiÀiÁÝUÀ LzÀÄ UÀÄA¥ÀÄUÀ¼À°è MlÄÖ MA§vÀÄÛ 
DAiÉÄÌUÀ¼ÀÄ zÉÆgÉAiÀÄÄvÀÛªÉ. 
 
C. zÀ¥Àà CPÀëgÀ, NgÉ CPÀëgÀ, PÉ¼ÀUÉgÉ 
D. CqÀØUÉgÉ 
E. UÁvÀæ »VÎ¸ÀÄ, UÁvÀæ PÀÄVÎ¸ÀÄ 
F. CPÀëgÀzÀ §tÚ, »A¨sÁUÀzÀ §tÚ 
G. §Ä¯Él£ÀÄß ¸ÉÃj¸ÀÄ 



DAiÉÄÌUÀ¼ÀÄ : 
zÀ¥Àà CPÀëgÀ - CPÀëgÀªÀ£ÀÄß zÀ¥ÀàªÁV¸À®Ä 
NgÉ CPÀëgÀ - CPÀëgÀªÀ£ÀÄß NgÉAiÀiÁV¸À®Ä 
PÉ¼ÀUÉgÉ - CPÀëgÀzÀ vÀ¼ÀzÀ°è UÉgÉ ªÀÄÆr¸À®Ä 
CqÀØUÉgÉ - CPÀëgÀzÀ ªÀÄzsÀå¨sÁUÀzÀ°è CqÀØªÁV UÉgÉ ªÀÄÆr¸À®Ä 
UÁvÀæ »VÎ¸ÀÄ - CPÀëgÀzÀ UÁvÀæªÀ£ÀÄß ºÉZÀÄÑªÀiÁqÀ®Ä 
UÁvÀæ PÀÄVÎ¸ÀÄ - CPÀëgÀzÀ UÁvÀæªÀ£ÀÄß PÀqÀªÉÄ ªÀiÁqÀ®Ä 
CPÀëgÀzÀ §tÚ - DAiÀÄÝ CPÀëgÀ/CPÀëgÀUÀ¼À §tÚªÀ£ÀÄß §zÀ¯Á¬Ä¸À®Ä 
»A¨sÁUÀzÀ §tÚ - »£Éß¯ÉAiÀÄ §tÚªÀ£ÀÄß §zÀ¯Á¬Ä¸À®Ä  
§Ä¯Él£ÀÄß ¸ÉÃj¸ÀÄ - ¸Á°£À DgÀA¨sÀzÀ°è §Ä¯Él£ÀÄß ¸ÉÃj¸À®Ä 
DAiÉÄÌ: `DAiÉÄÌ' ¥Àj«rAiÀÄ ªÉÄÃ¯É ¸ÀÆZÀPÀªÀ£ÀÄß MAiÀiÁÝUÀ JAlÄ DAiÉÄÌUÀ¼ÀÄ zÉÆgÉAiÀÄÄvÀÛªÉ.  
 
DAiÉÄÌUÀ¼ÀÄ 
CPÀëgÀ «£Áå¸À - CPÀëgÀ±ÉÊ°,UÁvÀæ,§tÚ ªÀÄvÀÄÛ EvÀgÀ ¥ÀoÀåUÀÄtUÀ¼À£ÀÄß DAiÀÄÄÝPÉÆ¼Àî®Ä/§zÀ°¸À®Ä  
KPÀ ¨sÁµÉ - PÉÃªÀ® PÀ£ÀßqÀ °¦AiÀÄ£ÀÄß §¼À¸À®Ä 
¢é ¨sÁµÉ - PÀ£ÀßqÀ ªÀÄvÀÄÛ EAVèÃµÀ °¦UÀ¼À£ÀÄß §¼À¸À®Ä 
EAf£ï ¤¶ÌçAiÀÄUÉÆ½¸ÀÄ/EAf£ï¸ÀQæAiÀÄUÉÆ½¸ÀÄ - EAf£ï ¤¶ÌçAiÀÄªÁUÀ¨ÉÃPÉÆÃ (Scroll 
Lock Off or F12 Key Off) CxÀªÁ EAf£ï ¸ÀQæAiÀÄªÁUÀ¨ÉÃPÉÆÃ (Scroll Lock On or 
F12 Key On) JA§ÄzÀ£ÀÄß ¸ÀÆa¸À®Ä F DAiÉÄÌAiÀÄÄ ®¨sÀå«zÉ. 
 
¸ÉÆÌçÃ¯ï¯ÁPï QÃ §¼À¸ÀÄ - £ÀÄr EAf£ï PÁAiÀÄð¤ªÀðºÀuÉAiÀÄ°ègÀÄªÁUÀ PÀ£ÀßqÀªÀ£ÀÄß DAiÉÄÌ 
ªÀiÁqÀ®Ä Scroll Lock Key AiÀÄ£ÀÄß §¼À¸À¨ÉÃPÁzÀ°è F DAiÉÄÌAiÀÄ£ÀÄß ªÀiÁrPÉÆ¼Àî¨ÉÃPÀÄ.  
 
J¥sï12 QÃ §¼À¸ÀÄ - £ÀÄr EAf£ï PÁAiÀÄð¤ªÀðºÀuÉAiÀÄ°ègÀÄªÁUÀ PÀ£ÀßqÀªÀ£ÀÄß DAiÉÄÌ 
ªÀiÁqÀ®Ä Scroll Lock Key QÃ §¼À¸ÀÄªÀ §zÀ¯ÁV F12 Key AiÀÄ §¼À¸À®Ä F 
DAiÉÄÌAiÀÄ£ÀÄß ªÀiÁrPÉÆ¼Àî¨ÉÃPÀÄ. 
 
JqÀPÉÌ ºÉÆA¢¸ÀÄ - ¥ÀoÀåzÀ ªÀiÁ»wAiÀÄ ¥ÀæwAiÉÆAzÀÄ ¸Á®£ÀÆß JqÀ ªÀiÁfð£ïUÉ ºÉÆA¢¸À®Ä 
ªÀÄzsÀå ºÉÆA¢¸ÀÄ - ¥ÀÄlzÀ ªÀÄzsÀåPÉÌ ºÉÆA¢¸À®Ä  
§®PÉÌ ºÉÆA¢¸ÀÄ - ¥ÀoÀåzÀ ªÀiÁ»wAiÀÄ ¸Á®£ÀÄß §® ªÀiÁfð£ïUÉ ºÉÆA¢¸À®Ä 
DgÉÆÃºÀtªÁV «AUÀr¸ÀÄ - DAiÉÄÌ ªÀiÁrzÀ ¥ÀoÀå ªÀiÁ»wAiÀÄ ¸Á®ÄUÀ¼À£ÀÄß PÀ£ÀßqÀzÀ 
CPÁgÁ¢AiÀiÁV DgÉÆÃºÀtPÀæªÀÄzÀ°è (C EAzÀ ¼À ªÀgÉUÉ) «AUÀr¸À®Ä  
+CªÀgÉÆÃºÀtªÁV «AUÀr¸ÀÄ - CªÀgÉÆÃºÀtPÀæªÀÄzÀ°è(¼À EAzÀ C ªÀgÉUÉ) «AUÀr¸À®Ä  
 
vÉÆÃj¸ÀÄ: `vÉÆÃj¸ÀÄ' ¥Àj«rAiÀÄ ªÉÄÃ¯É ¸ÀÆZÀPÀªÀ£ÀÄß MAiÀiÁÝUÀ JgÀqÀÄ DAiÉÄÌUÀ¼ÀÄ 
zÉÆgÉAiÀÄÄvÀÛªÉ.  

DAiÉÄÌUÀ¼ÀÄ 
G¥ÀPÀgÀt ¥ÀnÖ - ºÉÆ¸ÀPÀqÀvÀ, vÉgÉ ªÀÄÄAvÁzÀ DAiÉÄÌ G¥ÀPÀgÀtUÀ¼ÀÄ ºÁUÀÆ £ÀÄr ¯ÁAbÀ£À 



EgÀÄªÀ G¥ÀPÀgÀt ¥ÀnÖAiÀÄ£ÀÄß ¥ÀæzÀ²ð¹gÀ®Ä/ªÀÄgÉªÀiÁqÀ®Ä 
¹Üw ¥ÀnÖ - ¥ÀzÀ ¸ÀA¸ÁÌgÀPÀ CAPÀtzÀ PÉ¼ÀV£À ¹Üw ¥ÀnÖAiÀÄ£ÀÄß ¥ÀæzÀ²ð¸À®Ä/ªÀÄgÉªÀiÁqÀ®Ä 

G¥ÀPÀgÀtUÀ¼ÀÄ: ¥ÀzÀ ¥ÀjÃPÀëPÀ 
¸ÀA¥ÁzÀPÀzÀ°è ªÀiÁ»wUÀ¼À£ÀÄß Hr¹zÀ £ÀAvÀgÀ CxÀªÁ FUÁUÀ¯ÉÃ ¹zÀÞ¥Àr¹gÀÄªÀ PÀqÀvÀªÀ£ÀÄß 
¸ÀA¥ÁzÀPÀzÀ°è vÉgÉzÀ £ÀAvÀgÀ G¥ÀPÀgÀtUÀ¼ÀÄ-¥ÀzÀ¥ÀjÃPÀëPÀªÀ£ÀÄß DAiÉÄÌªÀiÁrPÉÆ½î. zÁR°vÀ 
¥ÀzÀªÀÅ ¥ÀzÀPÉÆÃ±ÀzÀ°è E®è¢zÀÝgÉ CzÀPÉÌ ¥ÀgÁåAiÀÄªÁzÀ ¥ÀzÀUÀ¼À£ÀÄß ¥ÀzÀ¥ÀjÃPÀëPÀªÀÅ ¸ÀÆa¸ÀÄvÀÛzÉ. 
CªÀÅUÀ¼À°è ¸ÀÆPÀÛªÉ¤¹zÀÝ£ÀÄß DAiÉÄÌªÀiÁrPÉÆ¼Àî§ºÀÄzÀÄ CxÀªÁ PÀqÉUÀtÂ¸À§ºÀÄzÀÄ. `§zÀ¯Á¬Ä¸ÀÄ' 
DAiÉÄÌAiÀÄ°è ¤ÃªÀÅ QÃ°¸ÀÄªÀ ¥ÀzÀªÀÅ ¥ÀzÀPÉÆÃ±ÀPÉÌ ¸ÉÃjPÉÆ¼ÀÄîvÀÛzÉ.  
QlQ: `QlQ' ¥Àj«rAiÀÄ ªÉÄÃ¯É ¸ÀÆZÀPÀªÀ£ÀÄß MAiÀiÁÝUÀ JgÀqÀÄ UÀÄA¥ÀÄUÀ¼À°è LzÀÄ DAiÉÄÌUÀ¼ÀÄ 
zÉÆgÉAiÀÄÄvÀÛªÉ.  
 
C. £ÉÃgÀ £ÀÄr 
D. ºÉÆ¸À QlQ, ªÉÄÃ¯É eÉÆÃr¸ÀÄ, ¸ÀªÀÄªÁV eÉÆÃr¸ÀÄ, ¯ÁAbÀ£À (Icon) eÉÆÃr¸ÀÄ 
DAiÉÄÌUÀ¼ÀÄ 
 
£ÉÃgÀ £ÀÄr - `£ÀÄr'AiÀÄ£ÀÄß EvÀgÀ vÀAvÁæA±ÀUÀ¼À°è §¼À¸À®Ä 
ºÉÆ¸À QlQ - ºÉÆ¸À QlQAiÀÄ£ÀÄß vÉgÉAiÀÄ®Ä 
ªÉÄÃ¯É eÉÆÃr¸ÀÄ - J¯Áè QlQUÀ¼À£ÀÄß ªÀÄÄZÀÑ®Ä 
¸ÀªÀÄªÁV eÉÆÃr¸ÀÄ - QlQUÀ¼À£ÀÄß ¥ÀPÀÌPÉÌ ¸ÉÃj¸À®Ä 
¯ÁAbÀ£À (Icon) eÉÆÃr¸ÀÄ - ¯ÁAbÀ£ÀUÀ¼À£ÀÄß eÉÆÃr¸À®Ä 
¸ÀºÁAiÀÄ: `¸ÀºÁAiÀÄ' ¥Àj«rAiÀÄ ªÉÄÃ¯É ¸ÀÆZÀPÀªÀ£ÀÄß MAiÀiÁÝUÀ JgÀqÀÄ UÀÄA¥ÀÄUÀ¼À°è ªÀÄÆgÀÄ 
DAiÉÄÌUÀ¼ÀÄ zÉÆgÉAiÀÄÄvÀÛªÉ.  
 
C. ¸ÀºÁAiÀÄ ¥Àj«r, QÃ°ªÀÄuÉ «£Áå¸À 
D. £ÀÄrAiÀÄ§UÉÎ DAiÉÄÌUÀ¼ÀÄ 
¸ÀºÁAiÀÄ ¥Àj«r - `£ÀÄr' vÀAvÁæA±ÀªÀ£ÀÄß §¼À¸À®Ä CUÀvÀåªÁzÀ ¸ÀºÁAiÀÄ ªÀiÁ»w ¥ÀqÉAiÀÄ®Ä  
QÃ°ªÀÄuÉ «£Áå¸À - `£ÀÄr' vÀAvÁæA±ÀzÀ QÃ°ªÀÄuÉ «£Áå¸ÀzÀ avÀæ ¥ÀqÉAiÀÄ®Ä  
£ÀÄrAiÀÄ§UÉÎ - `£ÀÄr' PÀÄjvÁzÀ ªÀiÁ»w  
 
G¥ÀPÀgÀt ¯ÁAbÀ£ÀUÀ¼À ¥ÀnÖ : 
1. ºÉÆ¸À PÀqÀvÀªÀ£ÀÄß ¥ÁægÀA©ü¸À®Ä 
2. FUÁUÀ¯ÉÃ EgÀÄªÀ PÀqÀvÀªÀ£ÀÄß vÉUÉAiÀÄ®Ä  
3. ¥ÀæzÀ±ÀðPÀ vÉgÉAiÀÄ ªÉÄÃ¯É EgÀÄªÀ PÀqÀvÀªÀ£ÀÄß G½¸À®Ä  
4. DAiÉÄÌ ªÀiÁrzÀ ªÀiÁ»w s̈ÁUÀªÀ£ÀÄß PÀvÀÛj¸À®Ä  
5. £ÀPÀ°¸ÀÄ - DAiÉÄÌ ªÀiÁrzÀ ªÀiÁ»w ¨sÁUÀªÀ£ÀÄß £ÀPÀ®Ä ªÀiÁr £ÀPÀ®Ä ¥sÀ®PÀzÀ°è Ej¸À®Ä  
6. CAn¸ÀÄ - £ÀPÀ®Ä ¥sÀ®PÀzÀ°è EgÀÄªÀ ªÀiÁ»wAiÀÄ£ÀÄß PÀqÀvÀzÀ ¨ÉÃPÉ¤¹zÀ eÁUÀzÀ°è 
CAn¸À®Ä  
7. ªÀÄÄ¢æ¸ÀÄ  
8. CPÀëgÀ «£Áå¸À  



9. JqÀPÉÌ ºÉÆA¢¸ÀÄ  
10. ªÀÄzsÀåPÉÌ ºÉÆA¢¸ÀÄ  
11. §®PÉÌ ºÉÆA¢¸ÀÄ  
12. C EAzÀ ¼À ªÀgÉUÉ CPÁgÁ¢  
13. ¼À EAzÀ C ªÀgÉUÉ CPÁgÁ¢  
14. ¥ÀæzÀ±ÀðPÀ vÉgÉAiÀÄ PÀqÀvÀªÀ£ÀÄß «zÀÄå£Áä£À DAZÉAiÉÆqÀ£É ¸ÉÃ¥ÀðqÉAiÀiÁV PÀ¼ÀÄ»¸ÀÄªÀÅzÀÄ 
 
15. £ÀÄr ¯ÁAbÀ£À (Nudi Direct) - `£ÀÄr' ¥ÀzÀ¸ÀA¸ÁÌgÀPÀªÀ£ÀÄß ©lÄÖ £ÀÄr °¦AiÀÄ£ÀÄß 
JA.J¸ï.ªÀqïð, ¥ÀªÀgï¥Á¬ÄAmï ªÀÄÄAvÁzÀ D£Àé¬ÄPÀ vÀAvÁæA±ÀUÀ¼À°è §¼À¸À®Ä EzÀ£ÀÄß 
QèQÌ¹zÁUÀ £ÀÄr ¥ÀzÀ¸ÀA¸ÁÌgÀPÀªÀÅ ªÀÄgÉAiÀiÁV `£ÀÄr' ¯ÁAbÀ£ÀªÀÅ ¥ÀæzÀ±ÀðPÀzÀ PÉ¼À CAa£À §® 
ªÀÄÆ¯ÉAiÀÄ°è PÁtÂ¹PÉÆ¼ÀÄîvÀÛzÉ. 

EvÀgÀ vÀAvÁæA±ÀUÀ¼À°è `£ÀÄr'AiÀÄ §¼ÀPÉ 

£ÀÄr ¥ÀzÀ¸ÀA¸ÁÌgÀPÀzÀ QlQ DAiÉÄÌAiÀÄ `£ÉÃgÀ£ÀÄr' AiÀÄ£ÀÄß DAiÉÄÌ ªÀiÁr.  

£ÀÄr ¸ÀzÀ¸ÀA¸ÁÌgÀPÀªÀÅ PÁtzÁV ¯ÁAbÀ£ÀªÀÅ vÉgÉAiÀÄ PÉ¼ÀUÉ §®ªÀÄÆ¯ÉAiÀÄ°è PÀÆgÀÄvÀÛzÉ.  

MSWORD, EXCEL, POWER POINT, PAGEMAKER EvÁå¢ J¯Áè 
vÀAvÁæA±ÀUÀ¼À®Æè PÀ£ÀßqÀªÀ£ÀÄß §¼À¸À®Ä FUÀ ¸ÁzsÀåªÁUÀÄvÀÛzÉ. 

UÀªÀÄ¤¸À¨ÉÃPÁzÀ PÉ®ªÀÅ CA±ÀUÀ¼ÀÄ 

UÀtPÀzÀ°è PÀ£ÀßqÀ CPÀëgÀUÀ¼ÀÄ ªÀÄÆqÀ¨ÉÃPÁzÀgÉ `Scroll Lock' ¢Ã¥À ºÉÆwÛgÀ¨ÉÃPÀÄ CxÀªÁ 
'F12' QÃAiÀÄ£ÀÄß §¼À¸À§ºÀÄzÀÄ.  

¥ÀæzÀ±ÀðPÀ vÉgÉAiÀÄ (Desk top) PÉ¼ÀUÉ §® ªÀÄÆ¯ÉAiÀÄ mÉæÃ£À°è `£ÀÄr' ¯ÁAbÀ£ÀªÀÅ EzÀÝgÉ EvÀgÀ 
vÀAvÁæ±ÀUÀ¼À°è `£ÀÄr'AiÀÄ£ÀÄß §¼À¸À®Ä ¸ÁzsÀå. F ¯ÁAbÀ£ÀªÀÅ E®è¢zÀÝgÉ PÉ¼ÀPÀAqÀAvÉ 
ªÀÄÄAzÀÄªÀgÉAiÀÄ¨ÉÃPÀÄ. 

¥ÀæzÀ±ÀðPÀ vÉgÉ ªÉÄÃ¯É EgÀÄªÀ Nudi 4.0 ¯ÁAbÀ£ÀzÀ ªÉÄÃ¯É QèQÌ¹. ¯ÁAbÀ£ÀªÀÅ vÉgÉAiÀÄ PÉ¼ÀUÉ 
§®ªÀÄÆ¯ÉAiÀÄ°è PÀÆgÀÄvÀÛzÉ. 

Nudi 4.0 ªÀÄÆ®PÀ £ÀÄr ¥ÀzÀ¸ÀA¸ÁÌgÀPÀzÀ°è PÉ®¸À ªÀiÁqÀÄwÛzÀÝgÉ `QlQ' ªÉÄ£ÀÄ«£À°èAiÀÄ `£ÉÃgÀ 
£ÀÄr' AiÀÄ£ÀÄß QèQÌ¹. £ÀÄr ¥ÀzÀ¸ÀA¸ÁÌgÀPÀªÀÅ PÁtzÁV ¯ÁAbÀ£ÀªÀÅ vÉgÉAiÀÄ PÉ¼ÀUÉ 
§®ªÀÄÆ¯ÉAiÀÄ°è PÀÆgÀÄvÀÛzÉ. 

MSWORD, EXCEL, POWER POINT, PAGEMAKER EvÁå¢ J¯Áè «AqÉÆÃ¸ï 
vÀAvÁAæ±ÀUÀ¼À®Æè PÀ£ÀßqÀªÀ£ÀÄß §¼À¸À®Ä FUÀ ¸ÁzsÀåªÁUÀÄvÀÛzÉ. 



JAJ¸ï D¦üÃ¸ï ªÀÄÄAvÁzÀªÀÅUÀ¼À°è PÀ£ÀßqÀªÀ£ÀÄß §¼À¸ÀÄªÁUÀ `Tools' ªÉÄ£ÀÄ«£À Auto 
Correct Option £À°è£À EAVèµï PÀÄjvÀ DAiÉÄÌUÀ¼À£ÀÄß §¼À¸À¨ÁgÀzÀÄ. 

JAJ¸ï ªÀqïð CxÀªÁ JAJ¸ï JPÉì¯ïUÀ¼À°è PÀ£ÀßqÀªÀ£ÀÄß §¼À¸ÀÄªÁUÀ Option s £À°è£À Spell 
Check ªÀÄvÀÄÛ Grammer Check UÀ¼À£ÀÄß §¼À¸À¨ÁgÀzÀÄ. 

JAJ¸ï ªÀqïð£À°è Tools -> Customize -> OptionTab -> List Font Names in 
their Font DAiÉÄÌAiÀÄ£ÀÄß C£ÀÆfðvÀUÉÆ½¹zÀgÉ CPÀëgÀ¥ÀnÖAiÀÄ°è CPÀëgÀUÀ¼ÀÄ ¸ÀjAiÀiÁV 
UÉÆÃZÀj¸ÀÄvÀÛªÉ. 

`£ÀÄr' vÀAvÁæA±ÀzÀ eÉÆvÉUÉ ¤ÃqÀ¯ÁVgÀÄªÀ CPÀëgÀ ±ÉÊ°UÀ¼ÀÄ (Fonts) [PÀ£ÀßqÀ ªÀÄvÀÄÛ EAVèµï 
CAQUÀ¼À£ÀÄß ¤ÃqÀÄªÀ CPÀëgÀ ±ÉÊ°UÀ¼ÀÄ (¥sÁAmïUÀ¼ÀÄ)]: 
Nudi 01 jAzÀ Nudi 18 gÀªÀgÉUÉ MlÄÖ ºÀ¢£ÉAlÄ CPÀëgÀ ±ÉÊ°UÀ¼À£ÀÄß ¤ÃqÀ¯ÁVzÉ. Nudi 
01e ªÀÄÄAvÁzÀªÀ£ÀÄß EAVèÃµÀ CAQUÀ½UÁVAiÀÄÆ Nudi 01k ªÀÄÄAvÁzÀªÀ£ÀÄß PÀ£ÀßqÀ 
CAQUÀ½UÁVAiÀÄÆ §¼À¸À§ºÀÄzÁVzÉ. 

 
Nudi Akshara ªÀÄvÀÄÛ Nudi Akshara 01 jAzÀ Nudi Akshara 14 gÀªÀgÉUÉ ºÀ¢£ÉÊzÀÄ 
CPÀëgÀ ±ÉÊ°UÀ¼ÀÄ PÀ£ÀßqÀ CAQUÀ¼À£ÀÆß Nudi Akshar ªÀÄvÀÄÛ Nudi Akshar 01 jAzÀ Nudi 
Akshar 14 gÀªÀgÉUÉ ºÀ¢£ÉÊzÀÄ CPÀëgÀ ±ÉÊ°UÀ¼ÀÄ EAVèÃµï CAQUÀ¼À£ÀÆß ¤ÃqÀÄvÀÛªÉ. 
 
¸ÀÆZÀ£É: ªÉÄÃ°£À CPÀëgÀ±ÉÊ°UÀ¼À£ÀÄß §¼À¸ÀÄªÁUÀ `KPÀ¨sÁµÉ' AiÀÄ£ÀÄß DAiÉÄÌªÀiÁrPÉÆArgÀ¨ÉÃPÀÄ. 
Nudi B-Akshara CPÀëgÀ±ÉÊ°UÀ¼À£ÀÄß §¼À¸À®Ä `¢é ¨sÁµÉ' AiÀÄ£ÀÄß DAiÉÄÌªÀiÁrPÉÆArgÀ¨ÉÃPÀÄ. 

 

«±ÉÃµÀvÉ ºÁUÀÆ G¥ÀAiÀÄÄPÀÛvÉUÀ¼ÀÄ 

ÀPÁðgÀªÀÅ ¤UÀ¢¥Àr¹gÀÄªÀ ²µÀÖvÉ, KPÀgÀÆ¥ÀvÉUÀ¼À£ÀÄß M¼ÀUÉÆArzÉ. 

GavÀªÁV zÉÆgÀPÀÄvÀÛzÉ. 

PÀ£ÀßqÀ ªÀiÁ»wUÀ¼À CPÁgÁ¢ «AUÀqÀuÉAiÀÄ ¸Ë® s̈ÀåªÀ£ÀÄß ºÉÆA¢zÉ;  
 
ºÀÄqÀÄPÀÄ, ºÀÄqÀÄPÀÄ-§zÀ°¸ÀÄ ªÀÄÄAvÁzÀ ¸Ë® s̈ÀåUÀ¼À£ÀÄß PÀ£ÀßqÀzÀ¯ÉèÃ ¤ÃqÀ¯ÁVzÉ;  

 
§ºÀÄªÀÄÄRåªÁV CPÁðªÉÇwÛ£À ªÀÄvÀÄÛ EvÀgÀ ¸ÀªÀÄ¸ÉåUÀ½UÉ ¸ÀªÀÄ¥ÀðPÀªÁzÀ ¥ÀjºÁgÀUÀ¼À£ÀÄß 

MzÀV¹zÉ;  
 



zÀvÀÛ ¸ÀA¸ÀÌgÀuÉUÉ CUÀvÀåªÁzÀ C£ÀÄPÀÆ®vÉUÀ¼À£ÀÄß MzÀV¹zÉ;  
 
C£ÉÃPÀ CPÀëgÀ±ÉÊ°UÀ¼À£ÀÄß ¤ÃqÀ¯ÁVzÉ;  

 
¥ÀzÀ¸ÀA¸ÀÌgÀuÉUÉ ªÀÄvÀÛµÀÄÖ ¸Ë®¨sÀåUÀ¼À£ÀÄß ¤ÃrzÉ;  

 
CAvÀgÀeÁ® ªÀÄvÀÄÛ «zÀÄå£Áä£À CAZÉ PÉëÃvÀæUÀ¼À®Æè PÀ£ÀßqÀªÀ£ÀÄß AiÀÄ±À¹éAiÀiÁV §¼À¸À®Ä 

¸ÁzsÀåªÁV¹zÉ; 
 
zÀvÀÛ ¸ÀA¸ÀÌ gÀuÉAiÀÄ ¸ÀAzÀ¨sÀðUÀ¼À°è, MAzÉÃ ¥ÀzÀUÀÄZÀÒzÀ°è wÃgÀ C¤ªÁAiÀÄðªÁV PÀ£ÀßqÀ 

ºÁUÀÆ EAVèµï JgÀqÀÆ ¨sÁµÉUÀ¼À°è ªÀiÁ»wUÀ¼À£ÀÄß zÁR°¹ §¼À¸À¨ÉÃPÁzÀgÉ CzÀPÉÌ 
CUÀvÀåªÁzÀ ¢é¨sÁµÁvÀäPÀ CPÀëgÀ ±ÉÊ°AiÀÄ£ÀÄß ¤ÃqÀ¯ÁVzÉ ºÁUÀÆ EzÀPÉÌ CUÀvÀåªÁzÀ 
vÀAvÁæA±ÀªÀ£ÀÄß C©üªÀÈ¢ÞUÉÆ½¸À¯ÁVzÉ;  
 
£ÀÄrAiÀÄ°è QÃ°¹zÀ ªÀiÁ»wUÀ¼À£ÀÄß AiÀÄÆ¤PÉÆÃqï ºÁUÀÆ AiÀÄÄnJ¥sóï8 ¸ÀAPÉÃvÀUÀ¼À 

PÀqÀvÀUÀ¼ÁVAiÀÄÆ PÁ¦qÀ§ºÀÄzÁVzÉ;  
 
¥ÀzÀ¥ÀjÃPÉë ¸Ë®¨sÀåªÀ£ÀÄß ¤ÃqÀ¯ÁVzÉ; PÀ£ÀßqÀPÉÌ CUÀvÀåªÁzÀ D£Àé¬ÄPÀ vÀAvÁæA±ÀUÀ¼À£ÀÄß 

C©üªÀÈ¢ÞUÉÆ½¸À®Ä CUÀvÀåªÁzÀ vÀAvÁæA±À C©üªÀÈ¢Þ ¸À®PÀgÀuÉUÀ¼À£ÀÄß (Software 
Development Kit) ¤ÃqÀ¯ÁVzÉ.  

§¼ÀPÉAiÀÄ PÉëÃvÀæUÀ¼ÀÄ 

«AqÉÆÃ¸ï (95, 98, J£ïn, 2000, JPïì¦) CAPÀtzÀ J®è D£Àé¬ÄPÀ (C¦èPÉÃ±À£ï) 
vÀAvÁæA±ÀUÀ¼ÀÄ 

¯ÉÆÃl¸ï ¸ÁägïÖ ¸ÀÆmï 

J®è jÃwAiÀÄ ¥ÀzÀ ¸ÀA¸ÀÌgÀuÉ (ªÀqïð ¥Áæ¸É¹AUï) (JAJ¸ï D¦üÃ¸ÀÄ, ¸ÁÖgï D¦üÃ¸ÀÄ, 
¥ÉÃeïªÉÄÃPÀgï EvÁå¢) 

zÀvÀÛ ¸ÀA¸ÀÌgÀuÉ (qÉÃmÁ ¥Áæ¸É¹AUï) (JAJ¸ï DPÉì¸ï, «µÀÄC¯ï ¨ÉÃ¹Pï, J¸ïPÀÆåJ¯ï, 
CgÁPÀ¯ï, «µÀÄC¯ï ¥sÁPïì¥ÉÆæÃ EvÁå¢)  

DAvÀjPÀeÁ® (EAmÁæ£Émï) ºÁUÀÆ CAvÀgÀeÁ® (ªÉ¨ï¸ÉÊmï) C£ÀéAiÀÄUÀ¼ÀÄ, «-CAZÉ 
(EAlgï£Émï) ¸ÉÃªÉUÀ¼ÀÄ. 

JA.J¸ï.ªÀqïð / JA.J¸ï.JPÉì̄ ï zÀ°è PÀ£ÀßqÀ §¼À¸ÀÄªÀ ¸Ë® s̈Àå  

JA.J¸ï.ªÀqïð£À°è £ÀÄr 4.0 jAzÀ F PÉ¼ÀV£À ¸Ë®¨sÀåUÀ¼ÀÄ zÉÆgÉAiÀÄÄvÀÛªÉ.  
 



PÀ£ÀßqÀPÁÌVAiÉÄÃ «±ÉÃµÀ PÀqÀvÀ JAJ¸ï ªÀqïð£À°è File->New DAiÉÄÌAiÀÄ £ÀAvÀgÀ Kannada 
JA§ÄzÀgÀ ªÉÄÃ¯É JgÀqÀÄ ¨Áj QèPï (Double click) ªÀiÁrzÁUÀ PÀ£ÀßqÀPÁÌVAiÉÄÃ «±ÉÃ±À 
C£ÀÄPÀÆ®vÉUÀ¼À£ÀÄß ¤ÃqÀ§®è ºÉÆ¸À PÀqÀvÀªÀÅ vÉgÉzÀÄPÉÆ¼ÀÄîvÀÛzÉ. ¸À®PÀgÀuÉ¥ÀnÖAiÀÄ ªÉÄÃ¯ÁãUÀzÀ°è 
£Á®ÄÌ ºÉÆ¸À DAiÉÄÌUÀ¼ÀÄ PÁt§gÀÄvÀÛªÉ. 
 
1. PÀ£ÀßqÀ-EAVèµï £ÀqÀÄªÉ CPÀëgÀ±ÉÊ°AiÀÄ §zÀ¯ÁªÀuÉ (Nudi Kannada-English) - 
¸ÀÆZÀPÀªÀ£ÀÄß ªÉÆzÀ® ¯ÁAbÀ£ÀzÀ ªÉÄÃ¯É QèPï ªÀiÁqÀ¨ÉÃPÀÄ. EzÀjAzÀ PÀ£ÀßqÀ ªÀÄvÀÄÛ EAVèÃµï 
¨sÁµÉUÀ½UÉ §zÀ°¹PÉÆ¼Àî®Ä ¸ÀÄ®¨sÀªÁUÀÄvÀÛzÉ. 
 
2. ºÀÄqÀÄPÀÄ §zÀ°¸ÀÄ (Nudi Find _Replace) - ¸ÀÆZÀPÀªÀ£ÀÄß ªÀÄÆgÀ£ÉAiÀÄ ¯ÁAbÀ£ÀzÀ 
ªÉÄÃ¯É QèPï ªÀiÁqÀ¨ÉÃPÀÄ. PÀ£ÀßqÀ ¥ÀzÀUÀ¼À£ÀÄß ¥ÀoÀåzÀ°è ¸ÀÄ®¨sÀªÁV ªÀÄvÀÄÛ ªÉÃUÀªÁV ºÀÄqÀÄPÀ®Ä 
ªÀÄvÀÄÛ §zÀ°¸À®Ä F ¸Ë®¨sÀåªÀ£ÀÄß §¼À¹PÉÆ¼Àî§ºÀÄzÀÄ.  
 
3. CPÁgÁ¢ «AUÀqÀuÉ (Nudi Sort) - ¸ÀÆZÀPÀªÀ£ÀÄß £Á®Ì£ÉAiÀÄ ¯ÁAbÀ£ÀzÀ ªÉÄÃ¯É QèPï 
ªÀiÁqÀ¨ÉÃPÀÄ. ¥ÀnÖPÉ (mÉÃ§¯ï) UÀ¼À°è CxÀªÁ ¥ÀAQÛAiÀÄ°è (¥ÁågÁUÁæ¥sï)£À°è ¹zÀÞ¥Àr¹zÀ 
ªÀiÁ»wAiÀÄ£ÀÄß PÀ£ÀßqÀ CPÁgÁ¢ «AUÀqÀuÉ ªÀiÁrPÉÆ¼Àî®Ä F ¸Ë®¨sÀåªÀ£ÀÄß §¼À¹PÉÆ¼Àî§ºÀÄzÀÄ.  
 

5 £ÀÄr ¥ÀzÀ¥ÀjÃPÀëPÀ (Nudi Spell Check) 

JA.J¸ï ªÀqïð ¸ÀA¥ÁzÀPÀzÀ°è ªÀiÁ»wUÀ¼À£ÀÄß Hr¹zÀ £ÀAvÀgÀ CxÀªÁ FUÁUÀ¯ÉÃ 
¹zÀÞ¥Àr¹gÀÄªÀ PÀqÀvÀªÀ£ÀÄß ¸ÀA¥ÁzÀPÀzÀ°è vÉgÉzÀ £ÀAvÀgÀ £ÀÄr ¥ÀzÀ¥ÀjÃPÀëPÀªÀ£ÀÄß 
DAiÉÄÌªÀiÁrPÉÆAqÀgÉ PÉ¼ÀV£À ZËPÀªÀÅ ªÀÄÆqÀÄvÀÛzÉ. 

 

zÁR°vÀ ¥ÀzÀªÀÅ ¥ÀzÀPÉÆÃ±ÀzÀ°è E®è¢zÀÝgÉ CzÀPÉÌ ¥ÀgÁåAiÀÄªÁzÀ ¥ÀzÀUÀ¼À£ÀÄß ¥ÀzÀ¥ÀjÃPÀëPÀªÀÅ 
¸ÀÆa¸ÀÄvÀÛzÉ. CªÀÅ UÀ¼À°è ¸ÀÆPÀÛªÉ¤¹zÀÝ£ÀÄß DAiÉÄÌªÀiÁrPÉÆAqÀÄ §zÀ°¹PÉÆ¼Àî§ºÀÄzÀÄ CxÀªÁ 



PÀqÉUÀtÂ¸À§ºÀÄzÀÄ. `¤WÀAlÄ«UÉ ¸ÉÃj¸ÀÄ' DAiÉÄÌAiÀÄ°è ¤ÃªÀÅ QÃ°¸ÀÄªÀ ¥ÀzÀªÀÅ ¥ÀzÀPÉÆÃ±ÀPÉÌ 
¸ÉÃjPÉÆ¼ÀÄîvÀÛzÉ.  

6DqÀ½vÀ ¥ÀzÀPÉÆÃ±À (Nudi Padakosha) 
PÀ£ÀßqÀ ªÀÄvÀÄÛ ¸ÀA¸ÀÌøw ¤zÉÃð±À£Á®AiÀÄªÀÅ ¥ÀæPÀn¹gÀÄªÀ, EAVèµï-PÀ£ÀßqÀ DqÀ½vÀ ¥ÀzÀPÉÆÃ±ÀªÀ£ÀÄß 
JAJ¸ï ªÀqïð£À°è ¤ÃqÀ¯ÁVzÉ. ¥ÀzÀPÉÆÃ±ÀzÀ°è ¸ÀÄªÀiÁgÀÄ 8,500 ¥ÀzÀUÀ½ªÉ. £ÀÄr 
¥ÀzÀPÉÆÃ±ÀªÀ£ÀÄß DAiÉÄÌªÀiÁrPÉÆAqÀgÉ PÉ¼ÀV£À ZËPÀªÀÅ ªÀÄÆqÀÄvÀÛzÉ. 
 
§¼ÀPÉzÁgÀjUÉ EAVèµïUÉ ¸ÀªÀÄ£ÁzÀ PÀ£ÀßqÀ ¥ÀzÀªÀ£ÀÄß ¥ÀqÉAiÀÄ®Ä ¤ªÀÄUÉ ¨ÉÃPÁzÀ EAVèµï 
¥ÀzÀªÀ£ÀÄß DAiÉÄÌ ªÀiÁrPÉÆAqÀÄ `¸ÉÃj¹' UÀÄArAiÀÄ£ÀÄß MwÛzÀgÉ CzÀPÉÌ ¸ÀªÀÄ£ÁzÀ PÀ£ÀßqÀ ¥ÀzÀªÀÅ 
vÉgÉAiÀÄ ªÉÄÃ¯É ªÀÄÆqÀÄvÀÛzÉ. 

¤ªÀÄUÉ ¨ÉÃPÁzÀ EAVèµï ¥ÀzÀªÀ£ÀÄß ¥ÀqÉAiÀÄÄªÀÅzÀÄ ºÉÃUÉ? 
-AiÀiÁªÀÅzÁzÀgÀÆ EAVèµï¥ÀzÀzÀ ªÉÄÃ¯É QèQÌ¹. 
- ¨ÉÃPÁzÀ ¥ÀzÀªÀ£ÀÄß ¨ÉgÀ¼ÀZÀÄÑªÀiÁr. 

JA.J¸ï.JPÉì¯ï£À°è £ÀÄr 4.0 jAzÀ F PÉ¼ÀV£À ¸Ë®¨sÀåUÀ¼ÀÄ zÉÆgÉAiÀÄÄvÀÛªÉ.  
 
PÀ£ÀßqÀPÁÌVAiÉÄÃ «±ÉÃµÀ PÀqÀvÀ JAJ¸ï JPÉì¯ï£À°è File->New DAiÉÄÌAiÀÄ £ÀAvÀgÀ Kannada 
JA§ÄzÀgÀ ªÉÄÃ¯É JgÀqÀÄ ¨Áj QèPï (Double click) ªÀiÁrzÁUÀ F ªÀÄÄA¢£ÀAvÉ MAzÀÄ 
¥ÀgÀzÉ.ªÀÄÆqÀÄvÀÛzÉ. 
 
FUÀ J£ÉÃ§¯ï ªÀiÁåPÉÆæÃ¸ï(Enable macro s) JA§ÄzÀ£ÀÄß DAiÉÄÌ ªÀiÁrPÉÆAqÀgÉ 
PÀ£ÀßqÀPÁÌVAiÉÄÃ «±ÉÃµÀ C£ÀÄPÀÆ®vÉUÀ¼À£ÀÄß ¤ÃqÀ§®è ºÉÆ¸À PÀqÀvÀªÀÅ vÉgÉzÀÄPÉÆ¼ÀÄîvÀÛzÉ. 
¸À®PÀgÀuÉ¥ÀnÖAiÀÄ ªÉÄÃ¯ÁãUÀzÀ°è £Á®ÄÌ ºÉÆ¸À DAiÉÄÌUÀ¼ÀÄ PÁt§gÀÄvÀÛªÉ.  

1. PÀ£ÀßqÀ-EAVèµï £ÀqÀÄªÉ CPÀëgÀ±ÉÊ°AiÀÄ §zÀ¯ÁªÀuÉ (Nudi Kannada-English) - 
¸ÀÆZÀPÀªÀ£ÀÄß ªÉÆzÀ® ¯ÁAbÀ£ÀzÀ ªÉÄÃ¯É QèPï ªÀiÁqÀ¨ÉÃPÀÄ. EzÀjAzÀ PÀ£ÀßqÀ ªÀÄvÀÄÛ EAVèÃµï 
¨sÁµÉUÀ½UÉ §zÀ°¹PÉÆ¼Àî®Ä ¸ÀÄ®¨sÀªÁUÀÄvÀÛzÉ.  

GzÁºÀgÀuÉUÉ MAzÀÄ ²Ãmï£À°ègÀÄªÀ J¯Áè ¸É¯ïUÀ¼À®Æè PÀ£ÀßqÀ CPÀëgÀUÀ¼ÀÄ ªÀÄÆqÀ¨ÉÃPÁzÀ°è 
J¯Áè ¸É¯ïUÀ¼À£ÀÄß DAiÉÄÌªÀiÁrPÉÆAqÀÄ ªÉÄÃ¯É ¸ÀÆa¹zÀ ¯ÁAbÀ£ÀzÀ ªÉÄÃ¯É QèPï ªÀiÁqÀ¨ÉÃPÀÄ. 

2. ºÀÄqÀÄPÀÄ (Nudi Find) - ¸ÀÆZÀPÀªÀ£ÀÄß JgÀqÀ£ÉAiÀÄ ¯ÁAbÀ£ÀzÀ ªÉÄÃ¯É QèPï ªÀiÁqÀ¨ÉÃPÀÄ. 
PÀ£ÀßqÀ ¥ÀzÀUÀ¼À£ÀÄß ¥ÀoÀåzÀ°è ¸ÀÄ®¨sÀªÁV ªÀÄvÀÄÛ ªÉÃUÀªÁV ºÀÄqÀÄPÀ®Ä F ¸Ë®¨sÀåªÀ£ÀÄß 
§¼À¹PÉÆ¼Àî§ºÀÄzÀÄ.  

3. ºÀÄqÀÄPÀÄ-§zÀ°¸ÀÄ (Nudi Replace) - ¸ÀÆZÀPÀªÀ£ÀÄß ªÀÄÆgÀ£ÉAiÀÄ ¯ÁAbÀ£ÀzÀ ªÉÄÃ¯É QèPï 
ªÀiÁqÀ¨ÉÃPÀÄ. PÀ£ÀßqÀ ¥ÀzÀUÀ¼À£ÀÄß ¥ÀoÀåzÀ°è ¸ÀÄ®¨sÀªÁV ªÀÄvÀÄÛ ªÉÃUÀªÁV ºÀÄqÀÄPÀ®Ä ªÀÄvÀÄÛ 
§zÀ°¸À®Ä F ¸Ë®¨sÀåªÀ£ÀÄß §¼À¹PÉÆ¼Àî§ºÀÄzÀÄ.  



4 CPÁgÁ¢ «AUÀqÀuÉ (Nudi Sort) - JPÉì¯ï£À°è ¹zÀÞ¥Àr¹zÀ ªÀiÁ»wAiÀÄ£ÀÄß PÀ£ÀßqÀ 
CPÁgÁ¢ «AUÀqÀuÉ ªÀiÁrPÉÆ¼Àî®Ä F ¸Ë®¨sÀåªÀ£ÀÄß §¼À¹PÉÆ¼Àî§ºÀÄzÀÄ.  

§¼À¸ÀÄªÀ «zsÁ£À:  

 

ªÉÄÃ°£À vÉgÉAiÀÄ°è ¸ÀÆa¹gÀÄªÀAvÉ ¤ÃªÀÅ CPÁgÁ¢ «AUÀqÀuÉ ªÀiÁqÀ¨ÉÃPÉA¢gÀÄªÀ 
PÁ®AUÀ¼À°ègÀÄªÀ ªÀiÁ»wUÀ¼À£ÀÄß DAiÉÄÌªÀiÁr. 

 

AiÀiÁªÀ PÁ®AC£ÀÄß DzsÁgÀªÁVlÄÖPÉÆAqÀÄ «AUÀqÀuÉªÀiÁqÀ¨ÉÃPÉÆÃ D PÁ®A C£ÀÄß «AUÀqÀuÉ 
PÁ®A£À°ègÀÄªÀ DAiÉÄÌAiÀÄ°è ¸ÀÆa¹. CgÉÆÃºÀt CxÀªÁ CªÀgÉÆÃºÀtªÁV «AUÀr¸À¨ÉÃPÉÆÃ 
JA§ÄzÀ£ÀÄß ªÀÄvÀÄÛ «AUÀqÀuÉ PÁ®A£À°è vÀ¯É§gÀºÀ EzÉ(Header Row) CxÀªÁ vÀ¯É§gÀºÀ 
E®è(No HeaderRow) JA§ÄzÀ£ÀÆß ¸ÀÆa¹ `«AUÀqÀuÉ' DAiÉÄÌAiÀÄ£ÀÄß ªÀiÁr.  

PÁAiÀÄð¤gÀvÀ¤UÉ PÉ® À̧ªÉÃ «±ÁæAw, Ȩ́ÆÃªÀiÁjUÉ À̧ÄªÀÄä£É PÀÄ½wgÀÄªÀÅzÉÃ PÉ® À̧:- ¸Áé«Ä 
«ªÉÃPÁ£ÀAzÀ 
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